
Theory of Operation
As used in reference to Windows NT, disk fragmentation means two things:

n a condition in which pieces of individual files on a disk are not contiguous, but rather are
broken up and scattered around the disk; and

n a condition in which the free space on a disk consists of little pieces of space here and 
there rather than a few large free spaces.

The effects of excessive fragmentation are two-fold as well:

n file access takes longer because a file must be collected in pieces here and there, 
requiring several disk accesses instead of just one; and

n file creations take longer because space for the file must be allocated in little pieces 
here and there instead of just one contiguous allocation.

Before the introduction of Diskeeper, there was no method for completely correcting the 
problems of file and free space fragmentation on Windows NT computers.

In designing Diskeeper Lite for Windows NT, the following goals were established:

n The product must be completely safe to use.

n It must improve Windows NT system performance.    It is not designed to make the disk 
look "pretty" — it is designed to improve disk performance and, as a result, overall 
system performance.

n It must defragment all possible files and consolidate free space into the smallest 
possible number of large spaces.



Overview of Diskeeper Lite
n Diskeeper Lite is supported on Windows NT 4.0.    It cannot be run on earlier versions of 

Windows NT.    Both the NTFS and FAT file systems are supported, but the HPFS file 
system is not supported.

n Diskeeper Lite operates on local (non-network) disk partitions.

n You must have Administrator privileges enabled before running Diskeeper Lite.

n With Diskeeper Lite, you can analyze the fragmentation on a disk (with a graphic or text 
display), as well as defragment the disk.

n Only one analysis or defragmentation operation can be performed at a time.    You can 
analyze or defragment only one disk at a time.

n Unlike "off-line" defragmenters, with Diskeeper Lite you can run other tasks while 
defragmentation is occurring.    However, since Diskeeper Lite runs at High priority, 
performance of other active processes will likely be impacted.

n Diskeeper Lite performs several "passes" through the files on the disk during the 
defragmentation process.    The number of passes varies, depending on the number of 
files and the degree of fragmentation.

n Diskeeper Lite differs from DOS-based defragmenters in that it does not move all the 
files to the beginning of the disk.    This is particularly true on NTFS partitions, since the 
beginning of the disk is reserved by Windows NT for the Master File Table (MFT).

n Unlike the full version of Diskeeper, Diskeeper Lite does not run as a Windows NT 
Service, and it does not log any events into the Windows NT Application Event Log.    
Click here for information about the full version of Diskeeper for Windows NT.

n Diskeeper Lite can be uninstalled in the standard manner using the Add/Remove 
Programs icon in the Windows NT Control Panel.    Click here for information about 
uninstalling Diskeeper Lite.



Using the Diskeeper Lite Interface
The Diskeeper Lite interface contains pull-down menus and a toolbar.    Many of the 
functions offered are the same on the menus and toolbar.

Click on the different areas of the Diskeeper Lite display shown below for information 
about that section of the Diskeeper Lite display.



Menu Options
Diskeeper Lite has these menu options:

    File Menu
    Analyze Menu
    Defragment Menu
    View Menu
    Options Menu
    Upgrade Menu
    Auto Defrag Menu
    Help Menu



Toolbar
The Diskeeper Lite toolbar offers these options:

    Go Button
    Pause Button

    Stop Button
 View Graphics Button
 View Text Button

 File Exclusion List Button
    Help Contents Button



Go Button
Click the Go button to begin either a fragmentation analysis or the defragmentation of the
selected disk.



Pause Button
Click the Pause button to temporarily pause a fragmentation analysis or the 
defragmentation of the selected disk.



Stop Button
Click the Stop button to stop a fragmentation analysis or the defragmentation of the 
selected disk.



View Graphics Button
Click the Graphics button to display a graphic view of either a fragmentation analysis or 
the defragmentation of a disk.

Click here to see an example of the fragmentation analysis graphic display.



View Text Button
Click the Text button to display a text view of either a fragmentation analysis or the 
defragmentation of a disk.

Click here to see an example of the fragmentation analysis text display.



File Exclusion List Button
Click the Exclusion List button to create a list of files or directories you want to be 
excluded from being defragmented.

Click here to see an example of the file exclusion list dialog box.



Exclusion List
When you choose the Exclusion List button or menu option, the window shown below 
appears.    Choose the various options shown in the window below for more information 
about the options:



Files
Use this section of the Exclusion List window to choose specific files (by name) to be 
excluded from defragmentation.    Choose the name of the file to be excluded, then click 
the Add Files button to add the file to the exclusion list.



Path
Use this section of the Exclusion List window to choose specific directories to be excluded 
from defragmentation.

Select a directory by highlighting it, then click the Add Path button to add the directory to 
the exclusion list.

When a directory folder is added to the exclusion list, any subdirectories below the 
directory in the tree are also excluded.



Drives
Use this section of the Exclusion List window to choose specific disk drives to be excluded 
from defragmentation.



Current Choice
This dialog box indicates the file, directory, or drive that has been selected for exclusion.    
It will not be added to the exclusion list until the Add Files button is clicked.



Add Files Button
Click this button to add the selected files to the Diskeeper exclusion list.



Add Path Button
Click this button to add the selected directory path to the Diskeeper exclusion list.



Exclusion List Box
This dialog box shows the files, directories, and drives that will be excluded from 
defragmentation.



Remove
Click this button to remove specific files, directories, or drives from the Diskeeper 
exclusion list.    To remove an item from the list, highlight the item by clicking on it in the 
Exclusion List Box and click the Remove button.



File List
This section of the Exclude Files dialog box lists the files matching the specification shown 
in the File Name edit box.



Directory Folder List
This section of the Exclude Files dialog box lists the directory folders in the selected disk..



Cancel Button
Choose the Cancel button to cancel any changes you have made to the Diskeeper 
exclusion list and return to the opening Diskeeper screen.



OK
Click on the OK button to accept any changes you have made to the Diskeeper exclusion 
list and return to the opening Diskeeper screen.



Save Button
Click the Save button to save the exclusion list and return to Diskeeper.



Help Button
Click the Help button to view help information about using the Diskeeper Lite File 
Exclusion List.



Help Contents Button
Click the Help Contents button to activate the Diskeeper Lite Help system.    Of course, if 
you’re reading this, you most likely figured this out already.



Disk Drive Icon
Double click any of the disk drive icons to alternately hide and display the Analyze and 
Defragment icons.



Analyze Icon
Click an Analyze icon to highlight it, then click the Go button to start a fragmentation 
analysis of the selected disk.    

Alternately, you can simply double click the Analyze icon to start the fragmentation 
analysis without needing to click the Go button.

When the fragmentation analysis is underway, the magnifying glass in the icon moves 
back and forth, because we figured you’d like to have something to watch while Diskeeper
Lite is analyzing your disk.



Defragment Icon
Click a Defragment icon to highlight it, then click the Go button to start the defragmenting
the selected disk

Alternately, you can simply double click the Defragment icon to start defragmenting the 
disk without needing to click the Go button.

When Diskeeper Lite is defragmenting a disk, the "magic hand" in the icon moves back 
and forth.    The "magic hand" is not really moving the files — Diskeeper Lite is!



Text Display Button
Click the Text Display Button to switch between a graphic display of your disk to a text 
report showing the fragmentation analysis information.

Click here to see an example of the fragmentation analysis text display.



Graphic Display Button
Click the Graphic Display Button to switch between a text report to a graphic display of 
the fragmentation analysis information.

Click here to see an example of the fragmentation analysis graphic display.



Text Display
Click on any of the areas of the Diskeeper Lite text display for a description about that 
part of the display.



Graphic Fragmentation Display
This section of the Diskeeper Lite display shows a graphic representation of the 
fragmentation of your disk.    The colors of the display indicate the type and condition of 
the data on your disk.    

n Green areas show system files such as the Master File Table (MFT).

n Yellow areas show the pagefile (if it exists on the disk).

n Light blue areas show the directories on the disk.

n Red areas show fragmented files.

n Dark blue areas show contiguous (non-fragmented) files.

n Gray areas show free space on the disk.



Status Bar
The status bar indicates the percentage done of either the fragmentation analysis or 
various stages of defragmentation.



File Menu
The File Menu contains these options:

    Open Analysis
    Save Analysis
    Print Analysis
    Exclusion List
    Exit



Open Analysis
Use the Open Analysis option to open and view a (previously saved) fragmentation 
analysis data file.    When this option is chosen, you are given the opportunity to select the
disk, directory, and filename of the fragmentation analysis file.

This option is useful for comparing the condition of a disk before and after defragmenting 
the disk with Diskeeper.    See the Save Analysis help topic for information about saving 
the fragmentation analysis results.



Save Analysis
Use the save Analysis option to save the results of a fragmentation analysis.    Use this 
option after running the fragmentation analysis.

By default, the analysis file is saved as a file named DriveX.any (where X    represents the 
drive letter) in the directory where Diskeeper is installed.    When this option is chosen, you
are given the opportunity to change the file name and directory location.

Note that if you are saving "before and after defragmentation" analysis files, you should 
use unique names for the files.    This prevents the "before" analysis file from being 
overwritten by "after" file. 

This option is useful for comparing the condition of a disk before and after defragmenting 
the disk with Diskeeper.    Be sure to save the analysis before running Diskeeper, so you 
can see the benefits of running Diskeeper.    See the Open Analysis help topic for more 
information about opening a (previously saved) fragmentation analysis data file.



Print Analysis
Use the Print Analysis option to print the text portion of a (previously saved) 
fragmentation analysis data file.    This option sends the fragmentation analysis 
information to whatever printer is designated as your default printer.

This option is useful for comparing the condition of a disk before and after defragmenting 
the disk with Diskeeper.    See the Save Analysis help topic for information about saving 
the fragmentation analysis results.



Exclusion List
Use the Exclusion List option to create a list of files or directories you want to be excluded 
from being defragmented.

Click here to see an example of the file exclusion list dialog box.



Exit
Use the Exit option to completely exit from Diskeeper Lite.    Using this option safely stops 
any analysis or defragmentation operation that may currently be running.



Analyze Menu
The Analyze menu contains these options:

 Select Disk
 Continue
 Pause
 Stop



Select Disk
Use the Select Disk option to select a disk to be analyzed.

When you chose the Select Disk option, a list is displayed of the disk partitions detected 
on your computer.    To select a disk, either click on a listed drive and click OK, or simply 
double click the listed drive.



Continue
Use the Continue option to continue a previously-paused fragmentation analysis of the 
selected disk.



Pause
Use the Pause option to temporarily pause the fragmentation analysis of the selected disk.



Stop
Use the Stop option to stop the fragmentation analysis of the selected disk.



Defragment Menu
The Defragment menu contains these options:

 Select Disk
 Continue
 Pause
 Stop



Select Disk
Use the Select Disk option to select a disk to be defragmented.

When you chose the Select Disk option, a list is displayed of the disk partitions detected 
on your computer.    To select a disk, either click on a listed drive and click OK, or simply 
double click the listed drive.



Continue
Use the Continue option to continue the previously-paused defragmentation of a selected 
disk.



Pause
 Use the Pause option to temporarily pause the defragmentation of the selected disk.



Stop
Use the Stop option to stop the defragmentation of the selected disk.



View Menu
The View menu contains these options:

 Graphics
 Text
 Orientation



Graphics
Use the Graphics option to display a graphic view of either a fragmentation analysis or the
defragmentation of a disk.

Click here to see an example of the fragmentation analysis graphic display.



Text
Use the Text option to display a text view of either a fragmentation analysis or the 
defragmentation of a disk.

Click here to see an example of the fragmentation analysis text display.



Orientation
Use the Orientation option to display the Diskeeper Lite orientation opening screen.    This 
display presents a brief "quick start" of Diskeeper Lite operation.



Options Menu
The Options menu contains these selections:

 Show Summary After Analysis
 Show Summary After Defragmentation
 Show Orientation on Launch



Show Summary After Analysis
Use the Show Summary After Analysis option to alternately enable and disable a summary
screen displayed after a fragmentation analysis.

This summary screen explains the condition of the analyzed disk, and makes 
recommendations based on the condition found.



Show Summary After Defragmentation
Use the Show Summary After Defragmentation option to alternately enable and disable a 
summary screen displayed after a disk is defragmented.

This summary screen explains the condition of the disk after defragmentation, and 
describes any situations found which might prevent Diskeeper Lite from completely 
defragmenting the disk.



Show Orientation on Launch
Use the Show Orientation on Launch option to alternately enable and disable the 
Diskeeper Lite orientation screen each time Diskeeper Lite is started.

The Diskeeper Lite orientation opening screen display presents a brief "quick start" of 
Diskeeper Lite operation.



Upgrade Menu
The Upgrade menu contains these options:

 Diskeeper Server
 Diskeeper Workstation
 Bulk Purchase



Diskeeper Server
Use the Diskeeper Server option to display information about the full-featured version of 
Diskeeper for Windows NT Server 4.0.

{button Diskeeper Server Information,EF(`S.HLP',`',1,`')}



Diskeeper Workstation
Use the Diskeeper Workstation option to display information about the full-featured 
version of Diskeeper for Windows NT Workstation 4.0.

{button Diskeeper Workstation Information,EF(`W.HLP',`',1,`')}



Bulk Purchase
Use the Bulk Purchase option to display information about bulk purchase discounts on the 
full-featured version of Diskeeper for Windows NT 4.0.

{button Bulk Purchase Information,EF(`B.HLP',`',1,`')}



Auto Defrag Menu
The Auto Defrag menu contains this option:

 Info



Info
Use the Info option to display a series of screens describing the features and functionality 
of the full-featured version of Diskeeper for Windows NT 4.0.



Help Menu
The Help menu contains these options:

    Contents
    About



Contents
Use the Contents option to view the Table of Contents for the Diskeeper Lite help system.



About
Use the About option to view the version number and other really interesting information 
about Diskeeper Lite.    



Disk
This section of the fragmentation analysis display shows which disk drive is being 
analyzed.



Disk Size
This section of the fragmentation analysis display shows the total amount of space on the 
disk.    This includes files and free space, as well as disk space used by the operating 
system (such as directory files and the Master File Table) but not reported in "Used 
Space".



Cluster Size
This section of the fragmentation analysis display shows the cluster size for the disk.    A 
disk cluster represents a number of disk sectors treated as a single unit. The entire disk is 
divided into clusters, each one a minimum increment of storage.



Used Space
This section of the fragmentation analysis display shows the total amount of disk space (in
kilobytes) currently occupied by files.    This does not include zero-length files, or certain 
files used by the operating system (such as directory files and the Master File Table).



Free Space
This section of the fragmentation analysis display shows the total amount of free space on
the disk.



Percent Free Space
This section of the fragmentation analysis display shows the percentage of space on the 
disk that is free.



Pagefile Size
This section of the fragmentation analysis display shows the size of the pagefile on the 
disk.    This section will display zero when no pagefile is present.



Pagefile Fragments
This section of the fragmentation analysis display shows the number of fragments the 
pagefile (if it exists on the disk) is broken into.



Total Directories
This section of the fragmentation analysis display shows the total number of directories 
present on the disk.



Fragmented Directories
This section of the fragmentation analysis display shows the number of fragmented 
directories on the disk.



Excess Directory Fragments
This section of the fragmentation analysis display shows the total number of directory 
fragments on the disk.    Contiguous directories are not counted in this total, but each 
piece of any fragmented directory is counted.



Total Files
This section of the fragmentation analysis display shows the total number of files on the 
disk.    This number does not include zero-length files or (in most cases) files less than one 
cluster in size on NTFS partitions.    Files less than one cluster in size may be included, 
depending on the file size and the cluster size.



Average File Size
This section of the fragmentation analysis display shows the average size of all the files 
on the disk.    This number does not include any zero-length files or pagefiles.



Fragmented Files
This section of the fragmentation analysis display shows the total number of fragmented 
files on the disk.



Excess Fragments
This section of the fragmentation analysis display shows the total number of file 
fragments on the disk.    Contiguous files are not counted in this total, but each piece of 
any fragmented file is counted.



Percent of Disk Fragmented
This section of the fragmentation analysis display shows the percentage of the disk that 
contains fragmented data.    For example, a figure of 33% indicates one-third of the disk 
contains fragmented files.    This figure is a good overall indication of the state of 
fragmentation on the disk.



Average Fragments per File
This section of the fragmentation analysis display shows the average number of 
fragments per file on the disk.    This is an index of how fragmented the files on the disk 
are.

If the average fragments per file is 1.00, the files are contiguous.    If the figure is 1.10, 
then 10% of the files, on average, are in two pieces.    1.20 means 20%, 1.30 means 30%, 
etc.    A figure of 2.00 means the files average two fragments each.    1.00 is the best figure
attainable, indicating that all files or nearly all files are contiguous.



MFT Size
This section of the fragmentation analysis display shows the size of the Master File Table 
(MFT).    

Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



Number of MFT Records
This section of the fragmentation analysis display shows the number of individual file 
records found in the Master File Table (MFT).    This figure will not necessarily correspond 
with the number of files presently on the disk, since in some cases the file records remain 
in the MFT after the file is deleted.

Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



Percent of MFT In Use
This section of the fragmentation analysis display shows the percentage of the Master File 
Table (MFT) in use.

The MFT grows as the number of files on the disk increases, but is not reduced in size 
when files are deleted from the disk.

Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



MFT Fragments
This section of the fragmentation analysis display shows the number of fragments the 
Master File Table (MFT) is broken into.

Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



Total Fragments
This section of the fragmentation analysis display shows the total number of file 
fragments on the disk.    Contiguous files are not counted in this total, but each piece of 
any fragmented file is counted.



Most Fragmented Files
This section of the fragmentation analysis display shows the directory path and filename 
of the most fragmented files on the disk, and the number of fragments the files are in.    If 
these files are ones that users access frequently, the impact to your system performance 
may be greater than indicated by the Average Fragments per File figure.



Number of Fragments
This section of the fragmentation analysis display shows the number of fragments 
associated with the most fragmented files on your disk.



Fragmentation Analysis Status Bar
When the fragmentation analysis is running, this section of the display shows the 
percentage of the analysis completed, and also displays a message indicating when the 
analysis is done.



Uninstalling Diskeeper Lite
Follow these steps to remove Diskeeper from your computer:

1. From Control Panel, double click Add/Remove Programs.

2. Click the Install/Uninstall tab.

3. Highlight Diskeeper Lite.

4. Click the Add/Remove button.    This removes the Diskeeper program files from your 
computer.



Executive Software
Executive Software, founded by its Chairman and CEO Craig Jensen, was incorporated in 
1981.    In 1986, Diskeeper for VAX/VMS was introduced, establishing Executive Software 
as the leader in defragmentation products for the corporate marketplace.

A fundamental aspect of the company’s corporate purpose has been to help Data Center 
Managers solve performance problems.    Superior technical capability coupled with 
meticulous market research fueled rapid growth for Executive Software, and resulted in a 
high degree of customer satisfaction.

Executive Software has grown from five staff in 1986 to more than 125 today, with 
headquarters in California and branch offices throughout the world.    The expansion of the
company and the popularity of its products demonstrate a successful implementation of 
the company’s purpose and the degree of technical and administrative capability that 
backs it up.

Click here to visit Executive Software’s Home Page:

{button Visit Executive Software,Inet("http://www.execsoft.com")}

Note:    It is necessary for you to have your Web browser or navigator up and running 
before clicking on the button.



Using the Diskeeper Help Internet Access
The Diskeeper Lite Help system gives you the ability to jump directly from the running 
Help system to the Internet.      This assumes, of course, that you have Internet access and
a browser or navigator on your system.

In the case that you have more than one navigational tool on your system, Diskeeper Lite 
is shipped with the file SETBROWS.EXE.    This is an executable image that allows you to 
specify the browse path for an Internet browser or navigator.

Using    SETBROWS.EXE
You only need use this option if you have more than one Internet navigational tool on your
system and want to specify a particular browse path for the browser or navigator, or if for 
some reason, you receive an error message requesting a browser.

Follow these steps to use SETBROWS.EXE:

1. Using the Windows NT Explorer, double click the SETBROWS.EXE file that is installed in
the directory where Diskeeper Lite is installed.    By default, this is ExecSoft\DkLite on 
your Windows NT system disk.    This causes the dialog box shown below to be 
displayed:

1.  Do one of the following:

n Enter the path and name of the browser or navigational tool.

n Click Browse.    Using the drives and directories, select the browser or navigational tool
and click OK.

1. Click OK.

Installing a Browser from the Internet
If you do not have a navigational tool on your system, but do have Internet access, you 
can download one of several such tools directly from the Internet.    Two popular browsers 
are Netscape and Microsoft Internet Explorer.    Their Web sites are:

Netscape Home Page http://home.netscape.com/

Microsoft Home page http://www.microsoft.com/





Frequently-Asked Questions
Why won  ’  t my disk defragment completely?   

Why doesn  ’  t Diskeeper move directories?   

Why doesn  ’  t Diskeeper defragment the Master File Table?   

Why doesn  ’  t Diskeeper defragment pagefiles?   

How can I handle pagefile fragmentation? 

Why doesn  ’  t Diskeeper completely consolidate the free space on my disk?   

Why don't my files get moved to the beginning of the disk?  

How do I get to the Dilbert Zone? 



Where’s Dilbert?
It’s easy . . . crank up your browser and click here!



Why won’t my disk defragment completely?
This can be the result of several situations:

n If your disk is extremely full, there may not be sufficient free space to effectively 
defragment the files.    In this case, we recommend temporarily moving some of the files 
off the disk, particularly large files.    This temporary measure often allows Diskeeper the 
"working room" it needs to complete the defragmentation process.    Also, this allows 
Diskeeper to defragment the free space on the disk, increasing the possibility that the 
temporarily-moved files can be moved back to the disk in a contiguous (or at least less-
fragmented) condition.

n Another cause for incomplete defragmentation is a fragmented pagefile. See Why 
doesn  ’  t Diskeeper defragment pagefiles?    for more information.

n A disk that has (at one time or another) been filled to capacity may have a severely 
fragmented Master File Table (MFT).    There is a White Paper entitled The Effects of 
Fragmentation on Windows NT File System Performance  available from the Executive 
Software Web page that describes the causes and effects of MFT fragmentation.    To 
view or download this White Paper, start your Web browser or navigator and click here.

n Another situation that can prevent complete defragmentation of a disk is the existence 
of a large number of directories on the disk.    See Why doesn  ’  t Diskeeper move   
directories?  for more information.



Why doesn’t Diskeeper move directories?
By its very design, Windows NT does not allow directories on a disk to be moved.    This is 
due to data integrity issues related to the way Windows NT maintains directory 
information while Windows NT is active.    Since    Diskeeper runs while other processes are 
active on the system, it does not attempt to move directories.



Why doesn’t Diskeeper defragment the Master File Table?
The Master File Table (MFT) is the area on an NTFS disk where Windows NT keeps all the 
information necessary for the operating system to retrieve files from the disk.    The MFT 
also contains information such as the file creation, modification, and backup dates and 
times.    In essence, the MFT contains everything Windows NT needs to know about the 
files on the disk.

Since the MFT is held open for exclusive use, Diskeeper is unable to move any pieces of 
this critical system file.    Otherwise, data integrity would be jeopardized.



Why doesn’t Diskeeper defragment pagefiles?
Diskeeper cannot defragment pagefiles, since pagefiles must be open for exclusive use by
Windows NT at all times.    See How can I handle pagefile fragmentation?  for information 
about handling pagefile fragmentation. 



How can I handle pagefile fragmentation?
The pagefile is open for exclusive use by the Windows NT system.    Diskeeper cannot 
defragment any file which is open for exclusive use.    There is, however, a way to 
defragment the pagefile, or at least reduce the degree of fragmentation of the pagefile.    
The steps are:

1. Create a new pagefile on another disk.

2. Reboot your computer to cause the system to use the new temporary pagefile.

3. Delete the original fragmented pagefile, PAGEFILE.SYS, in the root directory of the 
disk.

4. Run Diskeeper on the original disk.

5. Recreate the pagefile on the original disk.

6. Reboot your computer so the new pagefile will be used on the original disk.

7. Delete the temporary pagefile created in step 1 above.

You need to run Diskeeper on the original disk, since even with a fairly high percentage of 
free space, it is likely that free space will be quite fragmented.    A moderately large file 
like a pagefile will be created in a fragmented condition unless the free space has been 
consolidated prior to creating the file. 



Why doesn’t Diskeeper completely consolidate the free space on 
my disk?
There are several factors that can prevent the free space on a disk from being 
defragmented:

n A fragmented pagefile.    See How can I handle pagefile fragmentation?  for more 
information.

n A large number of directories on the disk.    See Why doesn  ’  t Diskeeper move   
directories?  for more information.

n On NTFS partitions, a portion of the free space on a disk is reserved by Windows NT for 
the Master File Table (MFT).    See Why don't my files get moved to the beginning of the 
disk?  for more information.

It is important to know that having all of the free space in a single, contiguous piece 
provides very little (if any) performance benefit.    Free space fragmented into hundreds of 
pieces will impact disk performance, but free space that’s in a few pieces should not have 
any effect on the performance of your disk.



Why don't my files get moved to the beginning of the disk?
On NTFS partitions, a portion of the free space on a disk is reserved by Windows NT for the
Master File Table (MFT).    This free space is most noticeable at the physical "beginning" of 
the partition (easily seen using the graphic fragmentation analysis display), but space is 
also reserved for use by the MFT in other areas of the partition.

Since this free space is reserved for exclusive use by Windows NT, Diskeeper Lite will not 
move files into these areas of the partition.



Upgrade Information
Diskeeper Lite is a scaled-down version of Diskeeper 2.0 for Windows NT.    Click one of the
buttons below for more information about the full-featured version:

{button Info,JI(`DKLITE.HLP',`General_Information')}    General information about the full 
version of Diskeeper for Windows NT

{button Safety,JI(`DKLITE.HLP',`Safety')}    The built-in safety guards 

{button Specs,JI(`DKLITE.HLP',`Specifications')}    Product specifications

{button Purchase,JI(`DKLITE.HLP',`Purchasing_Information')} Upgrade to the full version of
Diskeeper for Windows NT



General Information
The full-featured version of Diskeeper for Windows NT offers a number of enhancements 
not available in Diskeeper Lite.    Click one of the buttons below for more information about
the full-featured version:

    Fully Automatic Operation
    Server and Workstation Versions
    New Features!



Fully Automatic Operation
The full-featured version of Diskeeper for Windows NT is a completely automatic 
defragmenter, with full scheduling capabilities.    It runs transparently in the background, 
while you continue to work.    You can also schedule it to run during your "off hours" — you
can even set times when you DON’T want Diskeeper to run.

Diskeeper uses only idle resources, backing off when user or system needs increase. 

In all, Diskeeper is a truly "Set It and Forget It" product — once installed, fragmentation is 
eliminated from your Windows NT system, and you don't have to even think about it 
again! 



Server and Workstation Versions
Diskeeper for Windows NT comes in workstation and server versions.    The server version 
can remotely install, schedule, and monitor Diskeeper across an entire Windows NT 
network.

Note:    In a network situation, the required number of workstation and server licenses 
needs to be purchased before installing Diskeeper network-wide.    Bulk licenses are 
available at reduced rates at most resellers.



New Features!
Diskeeper 2.0 has the following enhancements and improvements:

n Fully compatible with Windows NT 4.0 (as is Diskeeper Lite)

n Does not modify any system files when you install it

n Includes the "Priority Defrag" feature (similar in operation to Diskeeper Lite), allowing 
you to perform a dedicated defragmentation of a disk, in addition to the fully automatic 
defragmentation mode

To purchase Diskeeper for Windows NT 3.51, or to order Diskeeper 2.0 for Windows NT 4.0 
in advance, click here.



Safety
When Diskeeper was designed, SAFETY was the highest priority.

To ensure the safe movement of files on the disk, Diskeeper uses mechanisms built into 
Windows NT 4.0 that were developed and implemented by Executive Software, and fully 
incorporated into Windows NT by Microsoft.    

By using these built-in mechanisms, Diskeeper maintains cache coherency, file security 
and permissions information, and file content integrity no matter how fragmented the files
on the disk are.

It is no wonder that Diskeeper is the preferred defragmenter, found on the computer 
systems at NASA, McDonnell Douglas, Lockheed, Boeing, AT&T, Unisys, Bechtel, E. I. 
Dupont, Northrop, Caterpillar, and many other companies. 



Specifications
Diskeeper for Windows NT 4.0 is supported on Intel x86 (including Pentium), Alpha, MIPs 
and PowerPC platforms running Windows NT 4.0.

Diskeeper safely defragments all types of FAT and NTFS files, including compressed files.

Diskeeper safely defragments open files, including system files — even when they are 
open, if not open for exclusive use.    

Diskeeper safely defragments all types of disks, including large capacity disks, all RAID 
configurations, including stripe sets, mirror sets, and volume sets.

Diskeeper is compatible with all types of database and application files.

In its "Set It and Forget It" mode, Diskeeper maintains a level of defragmentation which 
keeps your disks operating at optimal performance level while using only unused CPU 
cycles to accomplish the task.



Efficiency
In its automatic, "Set It and Forget It" mode, the full version of Diskeeper for Windows NT 
is very efficient, using only otherwise unused CPU cycles to perform its work.

One key design criteria was for the defragmentation process to use fewer resources than 
using the disk in a fragmented condition.    This criteria has been met in the full version of 
Diskeeper for Windows NT.



Purchasing Information
The full-featured version of Diskeeper for Windows NT is available from a wide array of 
computer resellers.    The following is a partial list.    In cases where a reseller’s name is 
underlined, you can click on the name to jump directly to their home page.    (Note that 
your Web browser or navigator must be active for this option to work properly.)

SOFTWARE HOUSE — 800-527-6389

THE CORNER STORE — 800-428-9672 or 205-649-5247

INACOM  — http://www.inacom.com —    800-843-2762

JSI — http://www.jsiinc.com — 800-585-9588

MICROAGE — http://www.microage.com    — 800-528-1415

PROGRAMMER  ’  S PARADISE   — http://www.pparadise.com — 800-213-4480

PROGRAMMER  ’  S SHOP   — http://computing.supershops.com — 617-740-2510

SOFTWARE SPECTRUM — http://www.swspectrum.com — 800-824-3323

STREAM INTERNATIONAL — http://www.stream.com — 800-677-4000

SUNBELT — http://www.ntsoftdist.com — 800-688-8404

TECH ARTS — http://www.techarts.com — 800-455-9853

EXECUTIVE SOFTWARE — http://www.execsoft.com — 818-547-2050

. . . or contact your favorite reseller!



Beta Release Information
This section provides information about the Diskeeper Lite Beta release.    Click any of the 
buttons below:

    Sending Us Beta Feedback
    Downloading the Latest Beta Release
    Known Limitations and FAQs



Sending Us Beta Feedback
Executive Software welcomes any feedback or comments about Diskeeper Lite.    We have 
set up e-mail capabilities via the World Wide Web specifically for the purpose of getting 
this type of information from you.    This is also the means by which you should contact 
Executive Software for any Technical Support issues you may have regarding Diskeeper 
Lite.

To access the Diskeeper Lite Beta feedback line, activate your Web browser or navigator 
and click the button below.

{button Diskeeper Lite Beta 
Feedback,Inet("http://www.execsoft.com/dklite/feedback.htm")}



Downloading the Latest Beta Release
Bug fix upgrades to the Diskeeper Lite Beta software will be made available from our Web 
site on an as-needed basis.    To access the Diskeeper Lite Beta download area, activate 
your Web browser or navigator and click the button below.

{button Download Beta Upgrades,Inet("http://www.execsoft.com/dklite/download.htm")}



Known Limitations and FAQs
To provide up-to-the-minute answers to questions you may have about Diskeeper Lite, 
Executive Software will make available a list of the known limitations and frequently-asked
questions.    This list will also identify which of these issues have been addressed in later 
Beta release updates (which will be made available for downloading from the Executive 
Software Web site).    To view this list (and download any available Beta release upgrades),
activate your Web browser or navigator and click the button below.

{button Known Limitations and FAQs,Inet("http://www.execsoft.com/dklite/litefaq.htm")}




